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	 Typefaces can be categorized as text types and display types. The basic difffrence is 
the size.
“Text type” is the main part of the copy. Normally the size of type for this purpose ranges 
from 8 to 12pt.
“Display type” starts at 14pt; usually it serves as a heading, or as a brief introduction to the 
main copy.
Display types have personalities: they can create awide range of expressions, from solemn 
to shoking.

Typestyles
	 Today an incredible number of typestyles are available to graphic designers. The 
number and variety have developed over time to accommodate divirse trends and uses. 
Most of these typestyles are simply variations in the weight or width of letterforms.
Typestyles are: roman, italic, regular, bold, light, condensed and extended.

The five classic typefaces are:

Garamond (France)  -  Old Style   1615;
Baskerville ( England)  -  Transitional   1757;
Bodoni (Italy)  - Modern  1788;
Century Expanded (U.S.)  -  Egyptian (Slab Serif) 1894;
Helvetica (Switzerland)  -  Sans Serif  1957;
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Myriad Pro Graphic design involves a deci-
sion-making process.

                Condensed Graphic design involves a decision-making 
process.

               Condensed Italic Graphic design involves a decision-making 
process.

               Bold Condensed Graphic design involves a decision-mak-
ing process.

               Bold Condensed Italic Graphic design involves a decision-mak-
ing process.

               Regular Graphic design involves a deci-
sion-making process.

              Italic Graphic design involves a deci-
sion-making process.

               Semibold Graphic design involves a deci-
sion-making process.

               Semibold Italic Graphic design involves a deci-
sion-making process.

               Bold Graphic design involves a deci-
sion-making process.

              Bold Italic Graphic design involves a deci-
sion-making process.

Arial Graphic design involves a de-
cision-making process.

               Regular Graphic design involves a de-
cision-making process.

              Italic Graphic design involves a de-
cision-making process.

              Bold Graphic design involves a 
decision-making process.

               Bold Italic Graphic design involves a 
decision-making process.

Arial Black Graphic design involves 
a decision-making pro-
cess.

Lucida Handwrithing Graphic design involves 
a decision-making pro-
cess.

Hobo Std Graphic design involves a deci-
sion-making process.

Bookmania Graphic design involves a deci-
sion-making process.
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American Typewriter Graphic design involves a deci-
sion-making process.

               Condensed Light Graphic design involves a deci-
sion-making process.

               Condensed Graphic design involves a deci-
sion-making process.

               Condensed Bold Graphic design involves a deci-
sion-making process.

               Light Graphic design involves a 
decision-making process.

               Regular Graphic design involves a 
decision-making process.

               Bold Graphic design involves a 
decision-making process.

Andale Mono Graphic design involves 
a decision-making pro-
cess.

Apple Braille Graphic design involves a decision-makG

ing process.

Apple Chancery Graphic design involves a deci-
sion-making process.

               Regular Graphic design involves a deci-
sion-making process.

               Italic Graphic design involves a deci-
sion-making process.

               Bold Graphic design involves a de-
cision-making process.

               Bold Italic Graphic design involves a de-
cision-making process.

Minion Pro Graphic design involves a deci-
sion-making process.

               Grafolita Script Graphic design involves a deci-
sion-making process.

               Memorian Pro Graphic design involves a de-
cision-making process.

Adeline Condensed Graphic design involves a deci-
sion-making process.

               Abati MT Condensed Extra Bold Graphic design involves a deci-
sion-making process.

               Abati MT Condensed Light Graphic design involves a decision-mak-
ing process.
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               Bold Graphic design involves a deci-
sion-making process.

               Bold Italic Graphic design involves a deci-
sion-making process.

Avenir Graphic design involves a 
decision-making process.

               Light Graphic design involves a deci-
sion-making process.

              Light Oblique Graphic design involves a deci-
sion-making process.

              Book Graphic design involves a de-
cision-making process.

               Roman Graphic design involves a de-
cision-making process.

               Book Oblique Graphic design involves a de-
cision-making process.

               Oblique Graphic design involves a de-
cision-making process.

               Medium Graphic design involves a de-
cision-making process.

Apple Symbols Graphic design involves a deci-
sion-making process.

Arrial Narrow Graphic design involves a deci-
sion-making process.

               Regular Graphic design involves a deci-
sion-making process.

               Italic Graphic design involves a deci-
sion-making process.

               Bold Graphic design involves a deci-
sion-making process.

               Bold Italic Graphic design involves a deci-
sion-making process.

Arial Rounded MT Bold Graphic design involves a 
decision-making process.

Athelas Graphic design involves a deci-
sion-making process.

               Regular Graphic design involves a deci-
sion-making process.

               Italic Graphic design involves a deci-
sion-making process.
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Bauhaus  93 Graphic design involves a deci-
sion-making process.

Bell Mt Graphic design involves a deci-
sion-making process.

Betnard MT Condensed Graphic design involves a deci-
sion-making process.

Big Caslon Graphic design involves a deci-
sion-making process.

Bodoni 72 Graphic design involves a deci-
sion-making process.

Bodoni 72 Book Italic Graphic design involves a deci-
sion-making process.

Bodoni 72 bold Graphic design involves a deci-
sion-making process.

Book Antiqua Graphic design involves a de-
cision-making process.

Book Antiqua bold italic Graphic design involves a de-
cision-making process.

Brush Script MT Graphic design involves a decision-making 
process.

               Medium Oblique Graphic design involves a de-
cision-making process.

               Black Graphic design involves a 
decision-making process.

               Black Oblique Graphic design involves a 
decision-making process.

               Heavy Graphic design involves a de-
cision-making process.

              Heavy Oblique Graphic design involves a de-
cision-making process.

Ayuthaya Graphic design involves 
a decision-making pro-
cess.

Baskerville bold Graphic design involves a de-
cision-making process.

Baskerville bold italic Graphic design involves a de-
cision-making process.

Helvetica bold Graphic design involves a 
decision-making process.
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Charter Graphic design involves a de-
cision-making process.

Cochin Graphic design involves a deci-
sion-making process.

Comic Sans MS Graphic design involves a de-
cision-making process.

Comic Sans MS bold Graphic design involves a 
decision-making process.

Consolas Graphic design involves a 
decision-making process.

Constantia Graphic design involves a de-
cision-making process.

Cooper Black Graphic design involves a 
decision-making process.

Copperplate Graphic design involves a 
decision-making process.

Copperplate Gothic bold Graphic design involves 
a decision-making pro-
cess.

Copperplate Gothic light Graphic design involves 
a decision-making pro-
cess.

Calibri Graphic design involves a 
decision-making process.

Calibri Bold italic Graphic design involves a 
decision-making process.

Cambria Graphic design involves a
 decision-making process.

Candara Graphic design involves a 
decision-making process.

Century Graphic design involves a 
decision-making process.

Century Gothic Graphic design involves a
 decision-making process.

Chalkboard SE Graphic design involves a 
decision-making process.

Chalkduster Graphic design in-
volves a decision-mak-
ing process.

Charlemagne Std Graphic design in-
volves a decision-
making process.
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Corbel Graphic design involves a deci-
sion-making process.

Courier Graphic design involves 
a decision-making pro-
cess.

Courier New Graphic design involves 
a decision-making pro-
cess.

Curlz Mt Graphic design involves a deci-
sion-making process.

Desdemona Graphic design involves a deci-
sion-making process.

Didot Graphic design involves a de-
cision-making process.

Engravers Mt Graphic design 
involves a deci-
sion-making pro-
cess.

Frankiln Gothic Medium Graphic design involves a deci-
sion-making process.

Freebooter Script Graphic design involves a decision-making 
process.

Gabriola Graphic design involves a decision-making 
process.

Garamond Graphic design involves a deci-
sion-making process.

Garamond italic Graphic design involves a decision-mak-
ing process.

Garamond bold Graphic design involves a deci-
sion-making process.

Grafolita Script Graphic design involves a deci-
sion-making process.

Herculanum Graphic design involves a 
decision-making process.

Hobo Std Graphic design involves a deci-
sion-making process.

Impact Graphic design involves a deci-
sion-making process.

Kefa Graphic design involves a deci-
sion-making process.

Lutania Graphic design involves a deci-
sion-making process.
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Lithos Pro Graphic design involves 
a decision-making pro-
cess.

Lucida Blackletter Graphic design involves a deci-
sion-making process.

Lucida bright Graphic design involves a 
decision-making process.

Lucida Caligraphy Graphic design involves a 
decision-making process.

Lucida Handwriting Graphic design involves 
a decision-making pro-
cess.

Luminari Graphic design involves a de-
cision-making process.

Lust Script Graphic design involves a 
decision-making process.

Marion Graphic design involves a deci-
sion-making process.

Marker felt Graphic design involves a deci-
sion-making process.

Memorium Pro Graphic design involves a de-
cision-making process.

Mimiun Pro Graphic design involves a deci-
sion-making process.

Mistral Graphic design involves a decision-making 
process.

Modern #20 Graphic design involves a deci-
sion-making process.

Monaco Graphic design involves 
a decision-making pro-
cess.

Noteworthy Graphic design involves a deci-
sion-making process.

Orator std Graphic design involves 
a decision-making pro-
cess.

Papyros Condensed Graphic design involves a decision-making 
process.

Papyros regular Graphic design involves a deci-
sion-making process.

Parpetua titling mt Graphic design involves 
a decision-making pro-
cess.
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Prestige Elite Std Graphic design involves 
a decision-making pro-
cess.

Phosphate Graphic design involves a 
decision-making process.

PT Mono Graphic design involves 
a decision-making pro-
cess.

Rockwell Graphic design involves a 
decision-making process.

Rockwell extra bold Graphic design in-
volves a decision-mak-
ing process.

Rosewood std Graphic design involves a 
decision-making process.

Sathu Graphic design involves a de-
cision-making process.

Signpainter Graphic design involves a decision-making 
process.

Stencil Graphic design involves a 
decision-making process.

Symbol Graphic design involves a 
decision-making process.

Times Graphic design involves a deci-
sion-making process.

Times italic Graphic design involves a deci-
sion-making process.

Times New Roman Graphic design involves a deci-
sion-making process.

Times New Roman itallic Graphic design involves a deci-
sion-making process.

Trajan Pro Graphic design in-
volves a decision-mak-
ing process.

Tratatello Graphic design involves a decision-making 
process.

Verdana Graphic design involves 
a decision-making pro-
cess.

Wide Latin Graphic design 
involves a de-
cision-making 
process.

Zapfino Graphic design involves 
a decision-making pro-
cess.
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Color
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Color wheel – provides an excellent system for understanding color 

relationships. 
 
Primary Triad – is made up of 3 colors: red, yellow, and blue. 
Secondary Triad – these colors are sum of 2 primary colors: orange, 
green, and violet. 
Tertiary Colors – combining a primary color with one of its secondary 
colors. 
 
Analogous colors – similar in hue, creating a smooth transition from one 
color to the next. 
Complimentary colors – are any two colors that are directly opposite one 
another on the color wheel. 

Tint – is what you get when you mix a color with white. Tints are 
also called pastels. 

Shade – is what you get when you mix a color with black. 
 

“Strong value contrast creates visual impact.” 
 
Every color has 3 properties: 
-  Hue - the base color – where is on the color wheel; 
-  Value  - the lightness or darkness; 
-  Intensity – the dullness or brightness. 
 

Color Schemes 

Color Schemes 
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Warm colors, like yellow, orange, and red, feel light. They 
have little weight, like sunshine. Warm colors expand forward, 
into the foreground of a design. 
 
Cool colors, like blues and greens, are darker and heavier. 
Cool colors shrink into the background of a design. 

RGB is an additive 
system, which means that 
when you add the 3 colors 
together, you get white. 
When none of the colors 
are present, you get black. 

If the 3 colors of the primary 
triad (red, yellow, and blue) are 
mixed together, the result is less 

color: in theory black. 

RGB Color

	 The RGB model forms its gamut from the primary additive colors of red, green and blue. When 
red, green and blue light is combined it forms white. Computers generally display RGB using 24-bit color. 
In the 24-bit RGB color model there are 256 variations for each of the additive colors of red, green and 
blue. Therefore there are 16,777,216 possible colors (256 reds x 256 greens x 256 blues) in the 24-bit RGB 
color model.

In the RGB color model, colors are represented by varying intensities of red, green and blue light. The in-
tensity of each of the red, green and blue components are represented on a scale from 0 to 255 with 0 being 
the least intensity (no light emitted) to 255 (maximum intensity). For example in the above RGB chart the 
magenta color would be R=255 G=0 B=255. Black would be R=0 G=0 B=0 (a total absence of light).

CMYK or "Process Color"

	 The CMYK printing method is also known as "four-color process" or simply "process" color. All of 
the colors in the printable portion of the color spectrum can be achieved by overlapping "tints" of cyan, 
magenta, yellow and black inks. A tint is a screen of tiny dots appearing as a percentage of a solid color.

Use RGB For Screen Displays and CMYK For Print

It is important to choose the right color model for the job. If your images will be printed, then convert 
them to CMYK and manually bring them into gamut before printing. If your images are to be displayed 
on a computer, then make sure you use RGB color so the full gamut will be available for display. Because 
both models can be available at the same time while using an application, it is easy to make a mistake and 
choose the wrong palette or set of color swatches.
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1.  Consider color associations when choosing colors for client. 

2.  Use red to incite a quick decision or blue to calm. 

3.  Try pink to improve concentration or green to refresh. 

4.  Choose adjectives related to the client, then find colors that 
associate with those words. 

5.  Change a color’s saturation to enhance or reduce its psychological 

effect. 

6.  Use harmonies for effective client color schemes. 

Applying Color Plasticity. 

Color Psychology


WHITE 
 

Purity 
Innocence 

Fresh beginnings 
Spirituality 
Cleanliness 

BLACK 
 

Elegance 
Sophistication 

Mystery 
Authority 
Power 

Strength 

ORANGE 
 

Warmth 
Contentment 

Vitality 

PINK 
 

Romance 
Femininity 

Youth 

RED 
 

Passion 
Heat 
Power 

Excitement 
Danger 

 

BLUE 
 

Tranquility 
Peace 

Reliability 
Solitude 

Melancholy 
 

GREEN 
 

Life 
Youth 
Hope 
Growth 
Affluence 
Jealousy 

 

YELLOW 
 

Happiness 
Playfulness 
Creativity 
Optimism 

 

PURPLE 
 

Luxury 
Wealth 
Royalty 

Eccentricity 
 

BROWN 
 

Authenticity 
Substance 
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Logo
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The Purpose of logo:
	 - Identification;
	 - Distinction;
	 - Communication;
	 - A logo is not a brand, but is one part of a brand;

A Logo should ...
	 - be simple;
	 - complement the company name;
	 - good look on black and white;
	 - be scalable;
	 - be original;

Doing your homework:
	 - the scope of the job;
	 - the company name;
	 - who is the customer?
	 - what kind of personality does the buisness project?
	 - who is the competition and how the company sees 
            themself as distinct from the competition?
	 - deadline and budget;

Genarating ideas: 
	 - mind maps;
	 - mood boards;
	 - sketching;
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Logo has only seconds to catch somebody’s attention, so there is no time for details.



                                                                                           A                                                                                                  35



                                                                                           A                                                                                                  37



                                                                                           A                                                                                                  39



                                                                                           A                                                                                                  41

	 “A shield harks back to heraldry. It signifies protection and authority. Shield logos are often used for law 
enforcement and for car companies as well as for sports teams. I'm going to recreate this shield that we see on the 
left. I'll begin with an ellipse. I'll tap m to go to my rectangle tool. I'll draw a rectangle over that. I'll then select 
both, come to my Path Finder and choose Minus Front.

I'll adjust the scale, I'll come and tear off my Pen panel. Then, with the Anchor Point tool, I'm going to click on 
that bottom anchor point. But to reintroduce some curve to it, I will click and drag to the right, holding down 
the shift key. I'll now click and drag up to add a curve. I just need to widen that a little bit. I think some holding 
down the option or alt key to do that from the centerpoint.

I'm now going to make sure that this has no fill and a black stroke. I'll get this piece of type, which is on a layer 
above, and I will move this into position. To this, I'm going to apply an Arch Warp of 20 percent. I'll select the 
outside shield and then come to the Object menu, Path, and choose Offset Path. I'm going to offset the path by 
minus 1/4 inch to create an interior shape.

I need to just adjust ... Let's get all of these items centered. I'm just going to move that type down a fraction. All 
right, so now, with both of these shields selected, going to apply a gradient to their fill. I will use this gold gra-
dient that I got from the Gradients Metals group. Keeping them both selected, I'll then come and choose the 
Gradient tool and change the angle of the gradient.

I'll now select just the inner gradient and reverse the direction. That's going to give me a nice shine across the 
shield. Now, with the inner shield, I want to change its shape. I can't just scale it, because that's going to distort 
the shape too much. I'll drag down a guide to about there, tap c for my Scissors tool, and break the path at the 
point where the guide intersects the shape.

I'll then come and delete the top portion, go back to my Direct Selection tool by pressing a, select those two open 
end points, join them, Then, with my Anchor Point tool, I will reintroduce a curve. Now, to speed things up, a 
number of these pieces are already made and they're on the Paste board. I have this pattern here which is going 
to go into the interior shield.

I'll select that shield and use my guides to divide it into four quadrants. I'll grab the pattern, move that over into 
place, and duplicate it, holding down option or alt as I drag away from it, and then rotate it and position it. I'm 
just going to select both of those shields. I'd like to change the stroke weight to two points. These two pieces of 
the pattern selected, I will group them together, command or control + g, select the interior shield, copy it, hold 
down the shift key, select the pattern, paste that in front, then hold down the shift key to reselect the pattern and 
make that into a clipping mask.

Now, the problem with that is, if I hide the guide, you can see that the interior shield now has a variable width, 
or appears to have a variable width, stroke around it. The way we're going to get around that is by coming to the 
Layers panel. I just need to find where that is. It's on Layer One, actually. It's that one right there. I'm going to 
select it, and then I'm going to align the stroke to the outside.

Now we can turn that clipping group back on and the problem is solved. I'm now going to add in these keys. 
These are a Photoshop custom shape, nothing more than that. In a blank Photoshop document, just drew these 
onto my canvas and then copied and pasted them individually, so they don't come in as one single compound 
path. Copy, paste, compound shape.

Then we can apply a fill to them. But we already have them here, so I'm just going to use the ones that we have, 
and I'll scale those and rotate them as necessary. Now I want an interior shield shape. This time, for variety, I'm 
going to create that, or modify an existing symbol. I'll come to the Maps Symbols, my point here being that you 
can create a symbol in a number of different ways. I'll use this Interstate Highway symbol, I'll break the link to it, 
scale it up, ungroup it, delete the bit that we don't want, come and delete that anchor point, convert the top two 
anchor points so that we have a straight edge at the top, which just happens to be what I want in this case.

I'll now drag that over into position. Using the Eyedropper tool, I'll sample the fill and stroke of the outer shield. I 
am going to come to the Appearance panel. I think I want to make the stroke one point. I do want to move it in-
side the shield shape. From Transform, I'm going to make the scale of that stroke, let's try 96 percent. How does 
that look? No, let's go to 93 percent.

Okay. I'm going to do the same with this one. I'll try just applying the same percentage as I did, and that's a little 
bit too much in this case, so I'll revisit that transformation. This time, I will use 96 percent. Then, just to finish 
the whole thing off, bar the tweaking, I'm going to add in one more symbol. This is going to come from the Regal 
Vector pack.

I want to use this one, number nine. Again, I need to break the link to it. I'm going to come to my Reflect tool 
and reflect it across the vertical axis, just seems to look better facing the other way. Then I'll scale that down, po-
sition it, and I have a piece of type over here on the Paste board on a layer above. I'll just drag that into position. I 
said on a layer above, but it seems to be behind, so I need to just bring that to the front.

And there we have our shield. Slightly different shape second time around, but all the essential ingredients there. 
I'm not sure what all these mixed symbols add up to meaning, but hopefully, some of the techniques were use-
ful.”
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	 “The term seal refers to a wax impression embossed in paper to authenticate a document, 
and, through this historical association, a seal logo can convey a sense of trustworthiness and, 
perhaps also, a vintage feel. Let's see how we can recreate this simple seal logo, and we'll begin 
with a circle, and I'll make sure that that has a black fill, and we'll start out with no stroke.

I'm now going to copy and paste in front. Command C, command F, and then scale down that 
copy from the center point holding down option or alt and the shift key. I'll now come and 
choose my Type on a Path tool, and I'm going to click at the six o'clock point on the circle and 
type in my text. I want that text to be centered. That's going to put it at the 12 o'clock position.

I'll press command A to select all. Let's increase its size. Command, shift, more than. Because we 
want a real sense of tradition with this, I'm going to use trajan bold, and I'm going to make that 
26 points, and we want it to be white, and there's the type around the top of the circle. So, now, 
I want to duplicate that type for the bottom of the circle, holding down my option or alt key, I'll 
pull from this tic that indicates the alignment of the type into the center of the circle, triple click 
on the type, and, of course, we have to have a Latin motto here.

I'm going to use the trusted Lorem Ipsum. I'll select that, let's scale it down somewhat. I'm now 
going to come to my Type menu, Type on a Path, Type on a Path Options. I want this aligned to 
the ascender. Scale it down some more. I think we want this to be regular as opposed to bold, 
and I just need to 

leave enough space between the two pieces of type so that we can fit in a star.

I think I'm going to make that a little bit bigger, and I want to, now, shift up the base line, so I'll 
press command or control T, come to my baseline shift, and shift that by two points. Let's now 
draw a guide that indicates the center point. I'll come back and select the top type. We'll make 
that a bit smaller, and I'll now come and choose my star tool. Draw myself one star right there, 
and hold down option or alt, drag that over to the opposite side, and I didn't position that very 
well.

Let's get in a bit closer so I can see what I'm doing. O.K., I'll now select the original circle. Come 
to my Appearance panel, and I will make the stroke white. We'll leave it at one point. Come to 
the Effect menu, Distort and Transform, Transform, turn on my preview. I now want to scale 
that stroke, and I'm estimating, 90 percent.

So, now I'm going to come and add another stroke, again we'll start with one point. I'll come to 
Effects, Transform. This time I'm estimating 60 percent. Let's turn on the preview. Yep, that looks 
about right, and now I want a series of stars to go around that stroke. So, let's get the one star that 
we have. I'll copy that over outside the shape, and I'll make it quite a lot smaller, then come to my 
Brush panel, and I'm going to drag that star onto the Brush panel and make a pattern brush.

I want the spacing on the pattern brush to be 50 percent. I'll click O.K., now I'll return to the 
appearance panel, select my circle, select the stroke, and then I can apply the pattern brush to 
that stroke. Now, to finish this off, let's just take a look at the finished version. I'm just going to 
add in some pre-existing symbols that we already have in our symbols library. So, I'll come to the 
Symbols panel. You'll see their right there because they've been used in this document, but to get 
these we come to the Regal Vector Pack, and, of course, we need some sort of eagle like bird on a 
crest, so I'm going to drag that out.

I'm going to break the link to that symbol so I can edit it, and then I will make it white, drag it 
into position, and scale it from it's center point holding down option or alt and the shift key, and 
drop it into the center of our circle, and, next, I will add a crown, and I may be mixing my met-
aphors here, but who cares, so I'm just going to drag that onto my Art board, I'm going to break 
the link to it, and then I'm going to apply a white fill to that.

Again, we'll drag it into position, and we'll scale it relative to everything else we've got going on. 
I think I want to just make that inner stroke a little bit heavier, so I'll select that, and we can just 
bump up the white right there. Let's go for three points, O.K., and there is our seal logo.”
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	 “let's create this ribbon, starting with this type in a red rectangle. I have a guide marking 
the center point of that rectangle. With my Rectangle Tool, I'm going to draw another rectangle 
over the bottom-left corner, switch to my Eyedropper, and pick up the properties of the larger 
rectangle. I'm then going to change the alignment of the stroke to the inside, which is the same 
as the larger rectangle. Let's now move this behind the bigger rectangle, and I want to move it a 
little bit to the left as well.

Now I'll switch to my Pen Tool. Selecting the larger rectangle, and then choosing my Draw Be-
hind mode, I'm going to draw a triangle down here that will simulate the shadow. And I'm doing 
it behind just so that we make sure that it's a completely seamless join. I'm holding down the 
Shift key as I do this, except for that last stroke there, and then I'll make that into a filled path. I 
want to switch the Fill and Stroke properties so that it's filled with black and then make sure that 
it has no stroke.

Now I'm going to come to add in an anchor point right there, and I will drag that inside, like 
so. I'll then select those two elements that make up the back of the ribbon, group them togeth-
er, come to my Reflect Tool, and we'll reflect them across this guide, Alt or Option, click on 
the guide. We are reflecting across the vertical axis and making a copy. Now I'm going to select 

everything, come to the Effect menu, and choose Warp, Arch.

So when I choose Arch, I find that it doesn't work, or rather, it's arching each of the individual 
elements. So I need to cancel that and first of all group everything together, then I can come and 
apply my Arch effect, and I get the result I'm after. Incidentally, just a footnote to this, let me 
point out that we do have ribbons available in our Illuminate Ribbons symbol set. And you can 
adapt these to your needs, just drag them out onto the pasteboard, break the link to them, and 
then you can work with them as you need to.

But I think it's always preferable to create these pieces yourself, and that way you have a sense of 
ownership of them.”
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	 “Swooshes, swirls, organic ribbons. Whatever you want to call them, they can add a sense 
of playfulness, dimension and movement to a logo. They might be entirely abstract, or evoke the 
business of the company. So here are three examples of said swooshes, swirls or organic ribbons. 
I'm going to choose my brush tool, come to my brush panel and come down to "Wacom 6D 
Brushes." And let's begin with that one, the 27 Art Pen Brush.

And now I need to just experiment with this. Let's see how that goes. It'll take a few go's to get 
just the right sort of stroke. All right, let's say I like that one. I can select it, maybe I'll come to 
the brushes panel and perhaps change the angle a little bit. I am going to reduce the roundness. 
Let's experiment with the shape of the brush a bit. All right, I like that, so I'm gonna apply those 
changes to the strokes.

I will outline the stroke so that it's now a fill. Let me just delete this one at the top here so I've got 
enough room to work with. And now to contain it, just so that we tidy up the ends, I'm gonna 
draw a rectangle around it, and I'm gonna make sure that rectangle has no fill and no stroke. I'll 
select it and the shape, and then we'll make that into a clipping mask. Secondly, I'm gonna come 
to my brushes panel and to my Artistic_Calligraphic brushes and use a 30 point flat brush, and 
then just experiment with some strokes.

When I get one that I like, I'm just gonna duplicate it a couple of times. I outline the stroke and 
then I'll apply a gradient to that. Let's change the direction of the gradient. And now, with my 
direct selection tool, I'm gonna click in each one and change the direction of the gradient indi-
vidually. And then, to finish that up, I'll just group those together, and there's my symbol.

Now finally, for this dimensional ribbon, let's come back to my brushes panel and I'll try once 
again with that 30 point flat brush. All right, let's say I like that one. Now, I do wanna beef that 
up a little bit, so let's come to the brushes and to the brush options. I'll increase the size and I'll 
take the roundness way down.

As I did before, I will outline the stroke. And now, I'm gonna come to my shape builder. Let's 
now swipe over that shape builder tool, and I can join those segments together and we can have 
the reverse side as another segment. So let's just now apply some colors to these. I'm gonna select 
that bit and apply a gradient to that, and then select the front piece and we'll have a solid color 
applied to that.

And then, let's just come and select the reverse piece, and I use my gra-
dient tool and just adjust the angle of that gradient. So there we see 
three different approaches to creating swooshes or organic ribbons.”
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	 “ A symbol of love, of health, and of life itself, it's no surprise that the heart is such a popu-
lar logo symbol. Here I'm going to deconstruct two very effective heart logos, Habitat on the left 
and Wall's ice cream on the right. Let's move down here. I'm going to start by creating a heart. 
Let's start with a circle. Then I'll tear off my Pen tools and, with my Anchor Point tool, click on 
that bottom anchor point, and then with my Direct Selection tool, on the top anchor point.

I'm going to bring that down. Now I want to pull up this side. But when I do so, that's going to 
happen, so I need to hold down the alt key as I do that. I'm also going to hold down the shift key 
to constrain it. I'm going to pull down a guide to that point, because I want to make sure that this 
side comes up exactly the same. This time, I don't need the alt key, just the shift key. I could then 
... adjust that as necessary, maybe want to pull that down a little bit more.

Perhaps it's just a little bit too plump. I'll just reduce its width, holding down the option or alt key 
as I do so. Okay, now. Let's just remind ourselves where we're going. We want to create some-
thing like this. I'm going to increase the stroke weight, and then, let's draw a rectangle around 
that. It's a fantastic association of heart and home here. I'm going to make an anchor point on 
that path and bring that up.

Now, with my Scissors tool, I'll come and cut the path on the heart. Let's zoom in down there. 
You can see that path has been cut. I also want to delete the bottom segment of the house. Now 
let's grab that path segment right there and drag that onto that open anchor point. I'll swipe over 
those ... I'm in my Direct Selection tool ... And then join them. I'll now do the same thing over 
here and join them.

That's changed the shape of my heart in a somewhat undesirable way. I'm going to select that an-

chor point and drag that down a bit, holding down the shift key as I do so. I'll pull down a guide 
just to indicate how far that handle came down, and then do the same on that side. Now I will 
switch to my Ellipse tool and I'm going to draw myself a circle in there. I want it to match up, as 
much as I can, with that stroke.

I'll now duplicate that. I'll select these two pieces. Let's give them no fill. I'll comes and choose 
my Shape Builder and remove the bits that we don't want, so that we're left just with that. Now, 
just to finalize that, I'll select it all and group it together. In this example, once again, I'm going to 
begin with a heart. Let's increase the stroke weight on that.

Now I'm going to copy that, paste it in front and scale down the copy. I'll come to my Scissors 
tool and break the path on the large heart and delete that segment, then go back to my Scissors 
tool, break the smaller heart at the bottom, and now I want to separate these two. Let's drag that 
over like so.

Let's move that one back up a bit. These two anchor points here, I want those to be joined. Ac-
tually, that's going to distort it if I do it like that, so let me make sure I pull that one exactly onto 
there, like so, swipe over with my Direct Selection tool, and I want to join them. But I can't, 
because it thinks, for some reason, that these are not two open end points. I'm going to use a 
stealth tactic here.

I'm going to swith to my Outline Mode. I'll move that anchor point away. If I select one, then 
hold down the shift key and select the other, I'll come to Object Path. Now I will average them, 
across both axes. Now I can join them. I'll now go back to my Preview View Mode. And, to give 
this some character, I'm going to come to my width tool and pinch it in at the start and the end.

And then, possibly, just increase the weight of the whole stroke.”
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	 “ Nature is a deep and rich vein of logo symbolism. Trees, plants, flowers, and leaves, 
the sun, and the landscape. Nature inspired imagery has connotations of fertility, the seasons, 
growth, and renewal. Here are four approaches to creating a nature inspired logo based on a leaf. 
So, in the first example, I'm tracing over a leaf and creating a relatively, relative being the opera-
tive word, naturalistic leaf.

Then I'm switching to a completely geometric leaf, and then that suggests simplifying further 
just using the leaf shape, creating some sort of interaction between a repetition of that leaf, and 
then finally, switching to a different kind of leaf and experimenting with the negative space that 
is created between the two leaves. But let's start out with this first version. I'll come to the layers 
panel and I'm going to turn off the finish layer, turn on the image layer.

I'll also turn off the type layer. Tearing off my pen tools and starting with my pen tool, I will 
create a very simple outline based on straight line segments around the leaf. I'll then come to my 
anchor point tool and apply some rounding to those anchor points. Now, I will come to my pen-
cil tool and add in the veins of the leaf.

As I do this, I want to make sure that this option with the pencil is unchecked, edit selected 
paths. and I'm deliberately continuing these outside of the leaf shape. Now, let's select all of those 
elements and apply a Variable Width profile to them. I'll come and change the color to the dark 
green color.

These are my swatches panel. I'll select the major veins and increase the weight. I can now turn 
off the image, select the outline, and make its stroke none, make its fill the lighter green color, 
and then from the Effect menu come and apply a Inner Glow, which uses the darker green color.

Now, let me select everything, deselect the outline, and group all of the veins of the leaf by press-
ing cmd or ctrl + g. And I want to select the outline shape and copy that, cmd + c, select the 
veins, cmd or ctrl + f to paste the shape in front of that, extend the selection to the veins by hold-
ing down shift and clicking on them. And then make that into a clipping mask.

Let me go back to my pencil tool now. I'll just add in a stroke right there. That's going to be a two 
point stroke. Let's make it the variable width. I'm gonna come to my width tool and make that 
wider at the bottom and bit wider at the top too. Alright, I'm going to group all of that together. 
Let's turn the type back on. I'll come and apply a Twist effect to that, and scale it down into place.

Now, am I crazy about that? No, it's all right, but it's not gonna win any awards. It's too compli-
cated. So, that process then leads me to thinking: well, forget all that with the leaf. Let's work 
with a further simplified version of the leaf. I opened up the original image in Photoshop. I 
straightened it and I masked half of it. Bringing that back to Illustrator, I then manually traced 
that half in the same way as I did the first example.

That gives me a half, like so, and then from there, I use my reflection tool, Reflect to Copy, join 
those two pieces together, and then I'll copy that 'cause I'm going to use that as a clipping shape 
as well in just a moment. I drew the veins of the leaf again in a completely symmetrical way this 
time. I'll paste that clipping shape on top of those. Select those as well, and once again, make a 
clipping mask.

I've only made the veins yellow just so that we can see them. I'll now select them and they will 
become white. So, that was my thinking in that example and if we just look at the finished ver-
sion there is the leaf juxtaposed with the type. That led me to simplify further so that we have 
just the shape, no veins, just nothing more than a leaf shape, and what if we were to duplicate 
that shape and then spin it around, adjust its position, and then change its blending mode to 
Multiply.

And then jumping off from there, how about we just experiment with a different leaf shape 
entirely? This is a Photoshop custom shape filled with a gradient, and then when I reflected it 
and adjusted the position, unexpectedly, but somewhat fortuitously, I think the negative space 
that is created between the two is interesting. To me, it looks like a candle, and maybe there's 
something there that I can work with. So, those are my four variants on a leaf inspired logo.”
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	 “Maybe you're designing a logo for an architecture-related company or maybe you're 
designing a logo for an actual building, or maybe the company is strongly associated with a 
city known for a particular building or monument. Buildings can be a great source of logo in-
spiration. They might be literal or metaphorical, realistic or highly abstracted. I'm going to run 
through my attempt to create a logo for the De La Warr Pavilion, a fantastic modernist building 
located Bexhill-on-Sea on England South Coast.

For my first attempt, I placed a source image and I image-traced it and then simplified it as much 
as I could. Here is my source image, here it is in Photoshop, and I've used every trick I know to 
make this source image as crisp and as simple as possible. You can see that I've masked out any 
unnecessary detail. I've applied an excessive amount of sharpening, not that that improves the 
appearance of the photographic image but it will improve how it responds to tracing.

I've made it black and white, and I've increased the contrast. So when I trace this in Illustrator, 
that's the sort of result that I get. It's then a question of evaluating my tracing results, turning on 
Ignore White, taking down the noise, and then expanding the result and further cleaning this up. 
Requires a lot more cleanup. So I'm going to hide my edges and then come and choose my eraser 
tool to start with.

Just get rid of the stuff that we can easily remove. But I'm not gonna spend too long on this be-

cause even though it's getting simpler and I could invest more time to make it simpler, still it's far 
too complicated. But this was informative. Doing this has made me focus on what are the es-
sential elements of this. If we look at the Layers panel, we can see that I've gone through various 
iterations trying to distill it further, every time simplifying it a bit more than the last.

I've dispensed with the image tracing and now I'm just manually tracing using the pen tool to 
create solid objects and filling them. So I ended up with something like this. Still a work in prog-
ress but I think that this has some potential. I got there by manually tracing over the same source 
image a number of field shapes.

Now I'm going to use my Live Paint to fill them with color. So I'll start out by selecting this and 
before I go any further, I want to make sure that everything has a white fill and no stroke. Then 
I'll come and choose my Live Paint bucket and click to make a Live Paint group. It's now time to 
turn back on my Show Edges. On my Swatches panel, I have a color group.

I'm gonna start out by filling in the black areas. Now, of course, it helps to have the source im-
age near at hand when you're doing this. So let me just back out for a moment and... I'll turn the 
manual trace layer on and then just move it to the side. So now back with my Live Paint group. 
Let's hide those layers. I'm really working on the interplay of the positive and negative space 
here, and where the railings overlap the lighter parts of the building and the sky then they be-
come positive.

So there is some back and forth here and you're bound to go wrong at some points as I am do-
ing, but the nice thing about Live Paint, or one of the nice things about Live Paint, is that you can 
always go back and change your mind. Let's just see how I'm doing with that. You can see that 
it's very much a work in progress. Some things about this need to be fixed. Let's just go back and 
see where I was with the earlier version, but the essential point here is that through working with 
iterations of this, I've been able to really focus on what I think is the essence of the building and 
simplify it down to just the really essential parts.”
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	 “Advances in our software make it easier to apply dimensional effects like shines, gloss-
es, and bevels to our logos. And adding such effects can be a great way of refreshing an existing 
brand, and bringing a logo up-to-date. But we need to be careful that we don't introduce bitmap 
elements that are resolution dependent. In this chapter, I'm going to look at adding some popu-
lar effects, all of which will be completely scalable. Let's create a simple shine in the corner of our 
enclosing shape.

I'll start by rounding the corners. I'll then come and apply a warping effect, inflate by 10 per-
cent. I will then copy that shape, paste that shape in front, so that's CMD or CTRL + C, CMD or 
CTRL + F. I'll scale the copy from the center point holding down the OPT or ALT key, and then I 
will apply a gradient to that. Now I will come and get my gradient panel, which has gone missing 
in action, so I'll come choose it from the "Window" menu.

I want my gradient to be a white-to-white gradient, so I'll select the currently black gradient 
stop, hold down OPT or ALT and click on "white," and then I want to reduce its opacity to zero. 
I'll now choose my gradient tool and I'll just pull down from that top corner to determine how 
much of the gradient we see. And I might need to take a few go's at getting that just right, but 
that, essentially, is the technique.”

	 “By the careful overlapping of transparent design elements. We can create more colors, 
more shapes, and more meaning. You can use transparency in a conceptual way to convey the 
nature of the business or its values. Here are two approaches to working with Transparency. I'm 
going to start with Type, press cmd or ctrl t to bring out my Character Panel and then come to 
my Touch Type Tool. I want to rotate and overlap these letters.

I'll convert the Type to Outlines and Ungroup. One by one select the letters, and apply colors to 
them. Select all four letters, come to the Transparency Panel, and choose Multiply. Now actually 
I'm going to go a step further than that because I don't want to rely upon a blending mode to 
achieve these colors.

It's going to be unpredictable and I also want a bit more control of what colors I'm getting in the 
areas of overlap. So I'm going to duplicate that just holding down opt or alt and dragging away 
from it and I'll Rasterize the copy. Back to my Swatches Panel, I'll now use my Eye Dropper Tool 
to sample those overlap colors. I'll add them to my Swatches Panel as Global colors which I can 
then Edit.

I can now delete that Rasterized copy. On my outlined letters I'll Restore the Blending Mode 
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to normal and then come and get my Live Paint Bucket. I'll come and choose these colors, click 
to make a Live Paint Group, and apply these colors in those overlap areas. Now the reason I've 
made it Live Paint is because it's live. So if I decide I need to move these letters around, you'll see 
that the interaction remains in place.

If I decide I want to move these letters around, you'll see that the interaction of the colors re-
mains in place, but I realize that these colors are not quite what I want so I can now come and 
edit them. Let's say I want something like that. Let's turn on my Preview and you can see that 
that's going to update in place. Something like that. So that was the Touch Type Tool, creating 
outlines, ungrouping, applying the colors, experimenting with the Multiply Blend Mode, but 
not actually going there, segmenting the letters using Live Paint, and then filling in the different 
segments with separate colors.

Now let's come to this example. I'm just going to move over to the left and look at the finished 
version. This is where we're going with this, and as before I don't want to use Transparency 
for the same reason, but rather apply separate colors to the overlapping segments. So I'll select 
those three overlapping circles, come and get my Live Paint and I'm now going to use this color 
group. Click to make a Live Paint Group so we want the red to actually go there, and the blue to 
go there, and the green will go there, and then in the middle we want it to be black, but we also 
want a heart to replace that inner segment.

In order for this to work I need to spin this through 180 degrees and I'm now going to just come 
to my Symbols Panel where I have a heart already. This heart comes from the Web Icons, there it 
is, so I can just drag that out right there. I can break the link to it, with my direct selection tool I 
can delete the inner shape and there I have my heart. I'll now just put that into position and scale 
it accordingly.”

	 “Negative space refers to the white space or the paper color that shows through a design. What 
we see onscreen is from the Wikipedia entry on negative space. It's a visual conundrum, is it two people 
in profile or is it a vase? Using negative space to imply a shape reversed out of background could be a 
great way to add a twist to your logo. Negative space can be hard to deploy, but if you can pull it off it 
really adds something. It also provides an a-ha moment for viewers when they realize what the negative 
space connotes.

Here are some ways we can work with negative space. So I'd like to create this monogram. I'm going to 
position the G and the T relative to each other. I want the G to go behind the T. So I'll send that to the 
back and then I'll select the F. I'll start out by making that white. Ultimately it needs to be transparent 
but just while we're positioning it I'll make it white. And then scale it into position.

The type has already been converted to outlines. And in this particular case I just want to nudge it a bit 
to the left so that it's covering that space, and I think make it a little bit more noticeable as an F a little bit 
more distinct as an F by moving this cross bar down a fraction. I'll select those anchor points and then 
just use my down arrow to nudge that down and I also now need to just bring those anchor points out 
so they align with the right edge of the T.
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OK so having done that I'll now select everything. Come to my shape builder tool and I'm gonna hold 
down the option or alt key and delete the segments that make up the F. And the reason for that is that if 
we are placing this on a field of color, that that area represented by the F is always going to be transpar-
ent.

An often cited example of negative space is the yin-yang symbol. It's an interesting exercise to recreate 
one of these. I'll start with a circle and I'll give that circle a black two point stroke. I'm now going to copy 
that to the clipboard. We'll be needing this later. I'll put the stroke back to none. And now we'll choose 
my scale tool and because I'm working with artwork that has no fill and no stroke, I'm gonna move to 
my outline view mode.

And because it's very important that I'm precise here, I'm gonna get in nice and large on my view size. 
I'll hold down alt or option and click on the anchor point. I want a copy at 50% and then I'm going to 
drag down a copy from that to the bottom circle. I need to make sure that they line up exactly. Which it 
looks like they do. Now with both of those selected, I'll come to the object menu, transform, transform 
each.

I want copies of both of those circles at 25%. I'll now select all of the artwork. Come to my preview view 
mode, choose my shape builder. And I can combine those two shapes applying a color. And I can click 
on the interior shape to apply color to that. Here's where we need that circle that we copied to the clip-
board. I will now paste that in front and then we can group all of the artwork together.

In this example I want to show that sometimes the negative space not only between letters but within 
letters can be interesting. Helvetica is known for having a tear shaped counter inside the A. So if our 
logo has the word water in it, or if it's in any way water themed and we have an A in the logo name, 
perhaps we can explore this option. I've converted the type to outlines, but I need to go a step further. In 
fact I need to go two steps further.

I need to first of all un-group that so that I can select the individual words. And then so that I can get 
to that counter, I need to release the compound path. Now the compound path has been released. I can 
come and select it and apply a different color to it. We can also create negative space through repetition. 
I'm gonna select this cat shape and copy it and then paste it in back. With the copy that is pasted in 
back, I'm gonna nudge it out and up and change it's color.

I'll then repeat that, now it's working at the top because it's a relatively simple shape. Down here it's just 
getting visually confusing so maybe, just maybe, if this were our logo we could put some sort of enclos-
ing shape around it and make that into a clipping mask. We can also achieve some interesting negative 
effects through the use of compound shapes. Here I have two leaves placed on top of a field of black and 
overlapping that field of black.

I'll select those three elements then come to my pathfinder panel and I want to use this option here, ex-
clude. I'm going to hold down option or alt as I do this to make it into an editable compound shape. By 
which I mean I can now double click on any of those elements and move them around and that positive 
negative interaction will update.”

	 “I want to add a distressed look to a logo through the use of texture. I'll come to my Layers 
panel and turn on my Start layer, I'm going to come and tear off my Transparency panel, because 
I need to see that in conjunction with my Layers panel. Back to my Layers panel, and I will tar-
get the Start layer by clicking on the bulls-eye. I can now make a mask for this layer. When I do 
so, the mask begins as black, so I need to un-clip it. I now need to click on the thumbnail for the 
Opacity mask, because I want to actually put content onto the Opacity mask.

I'll come to the File menu, and choose Place. There's my texture file. I'm going to click and drag 
to position that over the logo. Now, I want to take this further and vectorize the texture, because 
I don't want the logo to be in any way resolution dependent. So, with the image still selected, and 
if I wanted to see the image by itself, I could hold Option or Alt, and click on the Opacity mask 
thumbnail. But, I actually want to see it in the context of the artwork.

So, with it selected, Image Trace, and I'll now come to my tracing options. I'll just turn off the 
preview while I make a few adjustments. I'm reducing the Threshold value to 115, and I'm re-
ducing the Noise, which is going to give me more detail, to five, and I'm also choosing to ignore 
white. I'll now turn back on the preview, and that's the result. I can now position the texture, and 
also scale the texture relative to the artwork to get the effect that I want.

And I just want to make the point that this texture is actually transparent. Let's return to the lay-
er itself. On my Layers panel, I have a layer called "Color", and when I turn that on, you see that 
we're actually seeing through the distressed portions of the logo.”
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- The color or colors you choose for your logo should enhance the attributes of the company. 
Color connotations are cultural, personal, and sometimes contradictory. Red symbolizes love, 
passion, and strength. It also conveys danger and aggression. Pink is feminine, sweet, and associ-
ated with childhood. Blue is calming, protecting, professional and serious. It also carries conno-
tations of authority and success. Brown is earthy, natural.

Orange conveys autumn, Halloween, and citrus fruits. If you are a football fan, it means the 
Dutch National Team. Green is healthy, fresh, natural, fertile and organic. In the US, it's also the 
color of money, and can be associated with envy. Black is solid and powerful. It can also connote 
mourning and death. Grey is practical, earnest, traditional and creative. White is the color of 
peace.

It connotes purity, and in a medical context, it's sterile. Yellow is warm, happy, and sunny. On 
the other hand, it's also associated with cowardice. Purple is sophisticated and classy. It's associ-
ated with affluence. There are positive and negative connotations to whatever color you choose, 
so don't get hung up on these associations. But do be aware of them. Typically, a logo has one 
prominent color, but there are many examples of logos that use multiple colors.

Using multiple colors can convey diversity and inclusivity, or a wide range of products.

Color Associations



                                                                                           A                                                                                                  63

Qualities of effective logos

Know your Client + Audience
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Resources:

1. www.udemy.com

2. www.lynda.com

   “Logo Design Techniques” by Nigel French
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